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To use LATEX is one thing, and very good introductions exist for learning. But
what do you need for installing a LATEX system on Windows? What do I do with
MiKTEX, why do I need Ghostscript, what’s TeXmaker, and why many people
favor Emacs, and above all, how does everything fit together?

This tutorial shall save the search an show step by step what you need and
how to setup the individual components.

I am always happy about suggestions and notes on possible errors. When reporting by
mail, please always include the version number:
Revision: 1643 Date: 2012-05-09 08:20:17 +0100 (We, 09 May 2012)

Many thanks to a number of readers for suggestions and corrections.
The correct addresses for this document are:

• http://www.latexbuch.de/files/latexsystem-en.pdf for the PDF version and
• http://www.latexbuch.de/install-latex-windows-7/ for the HTML-page.

The German version is available via http://www.latexbuch.de/latex-windows-7-installieren/
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1 Everyone can set up LATEX

LATEX is not just a program but a language and a methodology of describing documents
and gets used via a LATEX system. With that not only scientific papers can be prepared, but
also excellent letters, presentation and much more.

For all that have not worked with free software so far it may be strange in the beginning
to have to integrate different components to a system on their own, and some will not easily
have the heart to do so. For this I present my own environment that I use to generate from
LATEX Postscript and PDF as well as HTML.

This is not a introduction to LATEX, there are some excellent documents available in the
net as well as my book[17]. For beginners the best will be the “Not so short introduction to
LATEX 2ε”, delivered with approximately every LATEX distribution in <texmf>/doc/guides/
lshort/, or to be downloaded from CTAN.org1. Essential also is the UK TEX FAQ, to be
obtained from the UK TeX Archive[3]. Then we should mention l2tabu, that lists obsolete
commands and packages and their alternatives.

If you have severe problems with installation although using this tutorial, or have an-
other question related to LATEX, should not write to me personally but search in the Internet
and the FAQ. In case of continuous confusion you can post in the newsgroup Most ques-
tions can be answered there, and also concerning Windows installation this is preferrable,
because answers are for everyone’s benefits and numerous competent users and develop-
ers read along.

This guide applies to Windows 7, Vista and XP. It is not a substitute for the original docu-
mentations of the particular programs and building blocks 2. In case of errors or warnings,
consult the documentation of the particular program. This tutorial exclusively cares for the
mentioned programs. Sections concerning Emacs, as an example, cannot be transferred for
XEmacs without special care. More recent versions of programs usually work well (no
guarantee).

1CTAN is the abbreviation for Comprehensive TeX Archive Network, the complete collection of TEX related
software.

2See my post in de.comp.text.tex (in German)
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2 What do you need at all?

2 What do you need at all?

In order to be able to work efficiently, besides the main TEX distribution more components
are needed.

LATEX Distribution: MiKTEX The LATEX distribution is the core of the system. It contains
the most important programs needed for generation of DVI, Postscript and PDF, and all
additional packages that offer extended possibilities as e. g. musical typesetting, standard
layouts for different organizations, layout specialties, fonts, etc. .

The distribution is only responsible to transform an input to an output. The input itself
is created with the editor of your choice. I use MiKTEX 2.8. In my opinion this distribution
is easy to install, works quite good and is updated regularly. Depending on the user’s
choice, 90 up to 920 MB are to be downloaded.

Editor: Texmaker For keeping the beginning with LATEX as simple as possible, I recom-
mend Texmaker as Editor, differing from my personal setup.

I will skip instructions for the also popular TeXlipse, the Eclipse plugin. Everyone using
Eclipse will manage to get that additional package.

For pure mouse oriented users Texmaker is quite comfortable. Texmaker is well updated
and convenient to use, because besides graphical menus for most mathematical symbols
and all relevant commands it shows so called tool tips during typing of commands. Espe-
cially for a newbie in LATEX Texmaker is recommendable. Later you can switch to Emacs.

Nevertheless it has to be stressed that Texmaker misses some features that I like in Emacs,
e. g. a numerated table of contents view or a powerful handling of labels and cites. The
integrated spell-checker does not yet show the quality as Aspell does for Emacs.

Editor: Emacs + RefTeX + AUCTeX + Aspell If you already have worked with LATEX
under Unix, you might have used Emacs, one of the most powerful GNU programs.

I decided to switch to Emacs due to the add-ons AUCTeX and RefTeX. AUCTeX offers key-
board shortcuts for all important LATEX constructs, speeding up work significantly. AUCTeX
additionally shows in-editor preview of graphics, tables and formulas. This merges the
best from both worlds WYSIWYG and offline editing[11]. On insertion of cross references,
RefTeX lets the user select one out of a list of all existing labels, and does help with genera-
tion of these labels. Also insertion of bibliographic cites is efficient and fast with RefTeX.

Read the introductions or tutorials for Emacs and AUCTeX and get the Emacs reference
card. The initial learning effort pays out, it is overcompensated by fast and efficient work-
ing.

Moreover you have a spell checker called Aspell in Emacs. It contains dictionaries for
English, German and many others.

Graphics in Postscript with Ghostscript In the Unix world, Postscript is the exchange
format for vector graphics. Following this paradigm, it is best to include graphics as (En-
capsulated) Postscript (PS/EPS) in LATEX.
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2 What do you need at all?

From all Windows applications with their file formats, e. g. existing Word- or PowerPoint
drawings, Bitmaps or vector files like Visio, Postscript can be generated even if the appli-
cation does not support this directly. A Postscript printer driver, redirected to file output,
makes this possible. For viewing existing Postscript files and to make small changes you
need Ghostscript with its graphical front-end GSview.

HTML translation: TeX4ht TeX4ht has the advantage that it is contained as package
in the MiKTeX distribution. For usage see documentation in <texmf>/doc/html/tex4ht.
Though, if you want the absolutely most recent version, you can install manually. TeX4ht,
regardless whether packaged or self-installed, needs the program ImageMagick for graph-
ics conversion.

Summary and licensing The included package sizes mean the download sizes, not the
space needed for installation.

Program Size MB

MikTeX Setup 90–920 MB
Ghostscript for Windows (Download) 10 MB
GSview 3 MB

Texmaker 6 MB

GNU Emacs for Windows (Download) 45 MB
AUCTeX Windows Package (Download) 2 MB
GNU Aspell (Win32 version) 8 MB
LibPNG 1 MB
Emacs Config File
Emacs TEX Registry File

TeX4ht 1,5 MB
ImageMagick Windows Binaries 10 MB

Σ ca. 1 · 103 MB

All of the programs mentioned in this tutorial are at least free of charge, in most cases
even free software3. All licenses state that the distribution is allowed. Most of them allow
furthermore to change the source code, whereas some of them prohibit commercial sale.

You are invited to reward the individual projects financially. Each projects’ web page
tells you how.

3Which as is generally known is a difference to free of charge: “Free as free speech, not free beer.” See the pages
of the Free Software Foundation at http://www.fsf.org.
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3 Installation and Configuration

My system runs on Windows 7. Some access paths to certain configurations may deviate
on your system from the described. Access paths denominate entries in the start menu,
buttons and menu entries with their particular captions.

The step sequence is to be followed tightly due to program dependencies. If you use
another directory for a program, please to take care about this in subsequent steps.

3.1 Download and install MiKTEX

First of all get the web installer MikTeX Setup and run it. Now you have to decide between
the alternatives Basic and Complete. If you are connected to the Internet with broadband, it
is best to get Complete, otherwise the other one. When you get more familiar with MikTEX,
you can download single packages on request, so that limited connection to the Internet is
no obstacle.

The installation itself is quite easy: Simply click on continue until the installer finishes,
accepting all defaults. As the installer will download between 90 and 920 Megabytes, I
recommend not using a mobile phone connection for installing.

All programs can then be started directly from command line.

3.2 Graphics Preparation and Conversion

Configure the Postscript printer driver by Start→ Devices and Printers→ Add Printer. First
you select local printer and as adapter the FILE port, the right printer driver is the Apple Color
LaserWriter 12/600 (up to Windows Vista), resp. MS Publisher Color Printer (from Windows
7 on, “Generic” in the vendor list). The printer name is best set to “Postscript File”.

After installation do the following settings under Start → Devices and Printers →
Postscript File → Printer → Printing Preferences → Advanced → Document Options →
Postscript Options: Set Postscript-Output to “Optimal Portability” and TrueType Download
to “Contour”. The ICM Color Matching should be deactivated for avoidance of color adul-
terations.

From now on every Windows application can produce Postscript files by using the new
printer. The generated file—which should be given the file extension .ps instead of the
default .prn—can be viewed in GSview and converted to EPS.

For automatic further processing it is best to install Ghostscript for Windows (Download).
Ensure you get gs871w32.exe, since the newer versions are incompatible to current AUC-
TeX. For installation, there is nothing special to bear in mind (simply Enter until finished).
Because of the possible wish to view Postscript file for checkup, get and install GSview 4.9
Win32 (Download), the graphical front end of Ghostscript. During the installation, do set
the directory to C:\Programme(x86)\Ghostscript, too, and also as program group specify
the same as suggested during the installation of Ghostscript.

It exceedingly useful to add Ghostscript to the search path. So again, in Start→ Control
Panel → System and Security → System → Advanced → Environment Variables add to the
variable PATH the respective directory, e. g. C:\Programme(x86)\Ghostscript\gs8.71\bin,
separated by a colon. Attention: No spaces before or after entries of the PATH variable!
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3 Installation and Configuration

In order to simplify work in the long run I recommend to setup an “EPS Printer”, for
this I have a short tutorial, too: [16], only in German, sorry, but Google Translate will do a
fair job.

3.3 Configure Texmaker

Texmaker is installed quite rapidly: Like with MiKTEX simply accept all installer defaults.

3.4 Configure Emacs

One defect of Windows has to be fixed first: the absence of the environment variable HOME.
Environment variables allow to set paths or generally strings independent of particular
applications, and use them with all applications. For this create a new entry in Start →
Settings→ Control Panel→ System→ Advanced→ Environment Variables4, named HOME and
assign some path in which you like to have saved all individual settings. The directory
name should not contain spaces. Then create exactly that folder.

For all environment variables it is to be reckoned that if you want to set an environment
variable just for the current user, you create it in User Variables. If they should apply to all
users, create them in System Variables.

You need GNU Emacs for Windows (Download), and AUCTeX Windows Package (Download)
as precompiled package. Unpack the Emacs archive emacs-2x.x-bin-i386.zip into the
programs directory, resulting in a directory like e. g. C:\Programme\emacs. In exactly this
directory then unzip the archive auctex-11.xx-e2x.x-msw.zip, overwriting at least one
file. Most unzippers ask before doing that.

For easier starting Emacs, in directory C:\Programme\emacs\bin run the installer addpm.
exe and accept the settings. This creates a shortcut in the Windows start menu.

With this, Emacs is ready to run. To have easier access to the following configurations,
you may download my Emacs configuration file. Rename this file to .emacs and move it to
your HOME directory.

Listing 1: Contents of the file .emacs� �
(server-start)
(add-hook 'LaTeX-mode-hook 'turn-on-reftex)
(setq reftex-plug-into-AUCTeX t)
(setq-default ispell-program-name "aspell") �
 	
AUCTEX + RefTEX The integration of AUCTeX with RefTeX has to be activated separatedly.
For this, start Emacs and use it to create the configuration file .emacs within you HOME
directory (UNIX shortcut name ~) with C-x C-f ~/.emacs RET (The shortcut C-x stands for
the keyboard combination Ctrl-x, other keys equivalent. So translates to: Ctrl-x, Ctrl-f,
type “~/.emacs”, press Enter. The “~/” means the file to be located within your HOME
directory.). Here you add the following lines:

4To be accessed much faster by keyboard shortcut Windows key+Break, by the way.
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3 Installation and Configuration

(add-hook 'LaTeX-mode-hook 'turn-on-reftex)
(setq reftex-plug-into-AUCTeX t)

Ensure that you use the straight apostrophe in the expression, not some accent or typo-
graphic single quote.

Then save the file by C-x C-s, close Emcas with C-x C-c, and the setup is completed.
The installation was successful, if when opening a .tex file in the menu bar new entries
“Preview”, “LaTeX” and “Ref” appear.

If you want faster and smaller preview images, you have to get the additional graphics
library LibPNG from LibPNG. From the Website, download “libpng” and “zlib”. From the
Binary archive extract the two DLLs libpng14-14.dll and copy them to your directory
C:\Programme(x86)\emacs\bin. Do the same with the dependencies archive’s content bin\
zlib1.dll, and place it in the bin directory of Emacs as well.

In PDF-Mode with (C-c C-t C-p) you now can call Preview-LATEX with C-c C-p C-d.

Aspell Aspell servers as spell checker. After downloading the program (“Full Installer”)
and the dictionairy (“aspell-en-0.50-2-3.exe”) from GNU Aspell (Win32 version), first run the
program installer, accepting all defaults, then your dictionairy installer.

So once again, in Start → Control Panel → System and Security → System → Ad-
vanced → Environment Variables add to the variable PATH the respective directory, e. g.
C:\ProgramFiles(x86)\Aspell\bin\; separated by a colon.

Finally you let Emacs know to use Aspell for spell checking in future by adding the
following line to your .emacs configuration file:

(setq-default ispell-program-name "aspell")

3.5 File Types Setup

Only as a further simplification you create a new file type. First, add to your configuration
file .emacs as first line:

(server-start)

Then download my Emacs-TEX registry file and edit it—so do not simply double click but
right click and select edit. In line 6, containing the first @=, replace both occurrences of the
directory name C:\\Programme(x86)\\emacs with the name of the directory you installed
Emacs in. Take care that you really use two backslashes \\ path separators. Save the file
and use the double click to add it to the registry. Confirm that you want it when Windows
asks for.

You can do the same for further file name extensions like .bib, .sty, .cls and .lco. From
then on double clicking a .tex file leads to execution of Emacs. Now Emacs is completely
configured.

Now you have full system for generation of printer and camera ready documents in PDF
or Postscript. If you do not want to generate HTML, you are done at this point.
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3 Installation and Configuration

Listing 2: Contents of the file texfile.reg� �
Windows Registry Editor Version 5.00
[HKEY_CURRENT_USER\Software\Classes\texfile]
[HKEY_CURRENT_USER\Software\Classes\texfile\Shell]
[HKEY_CURRENT_USER\Software\Classes\texfile\Shell\Open]
[HKEY_CURRENT_USER\Software\Classes\texfile\Shell\Open\Command]
@="C:\\Program Files (x86)\\emacs-23.3\\bin\\emacsclientw.exe -n -a \"C:\\Program C

Files (x86)\\emacs-23.3\\bin\\runemacs.exe\" %1 %*"
[HKEY_CURRENT_USER\Software\Classes\.tex]
@="texfile"
[HKEY_CURRENT_USER\Software\Classes\.bib]
@="texfile"
[HKEY_CURRENT_USER\Software\Classes\.lco]
@="texfile"
[HKEY_CURRENT_USER\Software\Classes\.sty]
@="texfile"
[HKEY_CURRENT_USER\Software\Classes\.cls]
@="texfile" �
 	
3.6 Remedy if you have Admin Rights

Now start Emacs via the start menu. If your Windows user account has admin rights, you
may get an error message about a rights problem of folder .emacs.d/server/.

error: The directory `~/.emacs.d/server' is unsafe

Fix it by changing the owner: Close Emacs. Click on Start and enter cmd into the search
field. This opens a command window. Change into the Emacs"=folder below HOME by
typing

cd %HOME%\.emacs.d

There you enter the following command:

takeown /f server

You only need to execute the command if you have administrative rights, and only then
you are able to execute it.

3.7 Install TeX4ht and ImageMagick

TeX4ht is included in MiKTeX and, if you selected the total installation, already on your
hard disk for usage.

The precondition for TeX4ht on the one hand is Ghostscript that you installed in a pre-
vious section, and on the other hand ImageMagick, which gets configured as follows: Get
the ImageMagick Windows Binaries from the ImageMagick web site and install it. Simply
acknowledge the defaults, which automatically adds the converter program to your search
path.
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4 And now? Usage

If you want to employ the OpenOffice.org export of TeX4ht, a Zip packer has to be
available in the system. I apply Info-Zip for this, but only copy the file zip.exe to a directory
already covered by the search path. After first use of oolatex.bat, if you discover that
the generated file is corrupt, you can remedy by editing again the file C:\Programme(x86)
\MikTeX2.9\texmf\tex4ht\base\win32\tex4ht.env and replace the tags <oo-alt> and </C
oo-alt> by <oo> bzw. </oo> and vice versa, for activating an alternative processing.

4 And now? Usage

Congratulation! TeX4ht is now installed and the TEX system can generate all important
outputs.

What about exporting to Word? In principle there is no reason to export LATEX to Word,
but there are programs that convert LATEX to the Rich Text Format (.rtf), which you can
open in Word then. I sense the best way is via HTML or OpenOffice.org. This means:
convert LATEX with TeX4ht to HTML or OpenOffice.org, and then open the output in Word
resp. OpenOffice.org.

The generation of outputs is normally directed by the editor programs, there are buttons
and/or keyboard shortcuts for this. For the usage of the Emacs add-ons I refer to their
documentation. The access may be bitter, it is really worthwile.

TeX4ht usage TeX4ht is a flexible tool for converting LATEX to HTML, but with the loads
of options one easily looses overview at the beginning. With a little practice, nevertheless,
you can accomplish everything you imagine.

The TeX4ht documentation delivered is not so luxuriant. A comprehensive list of op-
tions, written to the log file, you get by calling

htlatex.bat myfile.tex "info"

at the command line for a arbitrary LATEX file. Be sure to call htlatex.bat, not just htlatex,
as this starts a MikTeX program instead.

Because I want XHTML as clear and as small files as possible, I tend to invoke by

htlatex.bat myfile.tex "xhtml,2,fn-in,NoFonts,fonts,graphics-,sections+,C
next"

for the conversion. This generates XHTML, separate files for two levels of sections, no
special font information but basic logical formatting, non-scaled graphics and helpful hy-
perlinks. If you like to have a more precise reproduction of the fonts, skip the option
NoFonts, which of course leads to bigger files. For a monolithic file specify a 0 instead of 2.

Graphics conversion For drawing, use vector oriented programs, like e. g. CorelDraw,
OpenOffice.org Draw, Visio or related. Generally it is strongly dis-advisable to create dia-
grams or graphics as bitmaps, with Photoshop, GIMP or similar programs. Applications
like Excel or PowerPoint also process their graphics vector oriented, and are able to gen-
erate nice Postscript files via our Postscript printer driver. These Postscript files then get
conversed to EPS [16]. MATLAB directly can produce PS/EPS.
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5 If something fails

The generated file with the extension .eps can be loaded into GSview in order to e. g.
control whether the bounding box has to be corrected. The bounding box can be showed
by selecting the menu entry Options→ Show Bounding Box.

In case the bounding box does not fit, the command File→ PS to EPS allows to set the
bounding box automatically or manually and save the output to a new file. Automatic can
be selected if the whole graphic should be used. Manual selection of the bounding box is
useful if unwanted head or foot lines should be cropped.

Attention: For generating Postscript or DVI graphic files have to be present in (Encapsu-
lated) Postscript (EPS), whereas with pdfLATEX only graphics in PDF, JPEG oder PNG can be
processed. It is well possible to convince the one and the other to accept all file types, but
has to use special options which may make the source document unportable to other sys-
tems. If both DVI and PDF should be generated, the graphics have to exist in two formats.

If you want to use pdfLATEX to create Portable Document Format from your documents,
you have to convert the EPS files to PDF. For this there is the command epstopdf, like the
following:

epstopdf file1.eps

Bitmap files like JPEG or PNG can be processed directly by pdfLATEX. For usage with the
normal LATEX they have to be converted to EPS using bmeps.

5 If something fails

If anything does not work or behaves apparently wrong, often the reason is a forgotten en-
vironment variable. So you first should check whether all environment variables suggested
by this tutorial are set appropriately. If one misses or has a wrong value, it is possible that
a succeeding installation failed, especially that of Preview-LATEX. So do it again. Another
popular source of defect are files in wrong places. Go through the tutorial again and check
and correct if necessary.

If needed, risk a look to the installation manual of the particular package to find more
hints. Of course it cannot be ruled out that my tutorial contains an error. If you find
everything in the right place and still not working, ask me and include the version number
of the tutorial. Maybe I made some assumption that is not general, or a new version of a
package works different.

6 Prospect

With all the possibilities offered by the numerous LATEX packages always bear in mind:
Choose simple layouts and structure, especially if you plan to publish also in HTML.
With help of this article nevertheless it should be possible for a reasonably Windows-
experienced user to begin relatively quick with editing and typesetting texts.

If this document helps appeasing the timidity of installing and using such a system and
by that lowers the inhibition threshold of the access to LATEX, it has fulfilled its purpose.
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